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CHAPTER 1

Introduction
Following are the new features in this release of Flare.
For more information about each feature discussed in this manual, open the online Help and refer to
the "What's New" topic. Links are provided in some feature descriptions, taking you to topics that
contain additional information and steps.
Feature
"Micro Content" on
page 8

"CSS Variables" on
page 76

"Zendesk Plug-In" on
page 92
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What's New?
n

Short, concise information that stands alone and is easily consumable

n

Phrase/response combinations

n

Featured snippets in search results

n

Other possible uses (chatbots, FAQ databases, virtual and augmented reality instructions, field-level Help, etc.)

n

Set value in one place and reuse throughout stylesheet

n

Helps with speed, ease of use, and consistency

n

Ideal for setting colors

n

Publish Clean XHTML or HTML5 skinless output to Zendesk Help
Center dashboard

n

Beneficial for knowledge bases or FAQs that support service desk
tickets

n

Publish directly to categories and sections
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Feature
"Additional Features"
on page 120

"Deprecated Features"
on page 142
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What's New?
n

Chinese user interface in Flare

n

Elasticsearch enhancements

n

Interface themes—updated

n

Project templates—streamlined and updated

n

Start Page redesigned

n

Stylesheet Editor—ellipsis button for editing values

n

List of features that will be deprecated in this release

n

Recommended replacements for deprecated features
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CHAPTER 2

Micro Content
Micro content is what it sounds like—short, concise information that stands alone and is easily consumable. In Flare, it begins with the creation of a collection of brief phrases and corresponding
responses, such as questions and answers. After generating HTML5 output, these phrase/response
combinations can be used in different ways as users interact with your output. Among other benefits, it can greatly improve the user experience when people search in your HTML5 output.
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Uses for Micro Content
There are multiple potential uses for micro content, but some take more effort than others. As the
following diagram shows, there is one use—featured snippets in search results—that is quite easy to
produce, and all steps can be completed in a matter of minutes in Flare. As for other possible uses,
you can create the phrase/responses in Flare, but then you would also need to do additional work
outside of your project (possibly with the assistance of a third-party application) in order to produce
the final result. Just how much work depends on what you are trying to accomplish.
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Featured Snippets—Using Micro Content in Search Results
If you have used Google—and who hasn’t?—you have definitely seen objects that are known as
“Google Search Engine Results Page (SERP) features” that display on the page with regular search
results. There are all kinds of SERP features that you come across from time to time. One of these
is called a “featured snippet,” which provides an answer to a query, such as “How to change a tire.”
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Micro content that is created in a Flare project can result in custom featured snippets in your output’s search results. This is the easiest, most immediate way to use micro content from Flare.
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As with most of the SERP features that you see in Google, the featured snippets in Flare output
appear above regular search results, thus making them especially valuable. In other words, you can
always ensure that this targeted information is seen before anything else, rather than buried among
the rest of the results.

Although these are referred to as “featured snippets,” don’t confuse them with the regular snippets
in a Flare project. As you will see, micro content can be created with the help of regular snippets, but
that is purely optional.
NOTE: To create featured snippets for your search results, you need to be using either
Elasticsearch or MadCap Search as your search engine. Also, this feature is supported only
with HTML5 skins (Side Navigation, Top Navigation, Tripane), as well as skinless outputs.
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Chatbots and Other Uses for Micro Content
Featured snippets are quite easy to create and use right away, but there are other potential uses for
micro content as well. The list of possibilities is limited only by your imagination and available
resources. Here are just a few that you might consider:

CHATBOTS
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FIELD-LEVEL HELP
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FAQ DATABASES
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VIRTUAL AND AUGMENTED REALITY INSTRUCTIONS

To accomplish any of the above, you might need the assistance of an experienced programmer
and/or third-party applications.
For more information, see "How to Use Micro Content for Advanced Purposes" on page 49.
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Steps for Using Micro Content
Following are the primary steps for micro content:
1. Create The first step in using micro content, for whatever purpose, is to create it in Flare. This
entails adding a micro content file to the Content Explorer and then adding phrases and
responses within it. See the following:
n

"How to Add a Micro Content File to a Project" on page 41

n

"How to Create Phrases and Responses in the Micro Content Editor" on page 42

n

"How to Create Micro Content from a Topic or Snippet" on page 44

2. Enable in Search Results If you intend to use micro content in your HTML5 output search results, you need to make sure it is enabled in the target. See "How to Enable Micro Content" on
page 51.
3. Edit Look If you integrate micro content into your HTML5 search results, there are different
ways you can control its look. This is done in an HTML5 skin. See "How to Control the Look
and Size of Micro Content" on page 52.
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Micro Content File and Editor
To start creating micro content, you first must add a micro content file to the Content Explorer. It is
recommended that you create a subfolder named "MicroContent" under the Resources folder. Then
right-click on that subfolder, select New > Micro Content, and complete the fields to create the new
file. A micro content file opens in the Micro Content Editor, where you add phrases and responses.
Initially, you will see one phrase/response combination, which you can replace with your own content.
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Phrases
The first part of micro content is the phrase, which is what a reader uses when performing a search
(or interacting with, say, a chatbot). In Flare’s Micro Content Editor, you can use the local toolbar to
create and manage phrases. The phrases are listed in a grid, where you can use additional options
specific to each phrase. When you select a phrase in the grid, the associated response is shown in
the area to the right.

Toolbar
Button/Section

Description
Adds a new phrase to the grid below. Replace the generic text with your own
phrase.
You can also right-click in the grid and select Add Phrase from the context
menu. The keyboard shortcut option is CTRL+SHIFT+N.
Adds a new alternate phrase under the main phrase that is selected in the grid
below. Replace the generic text with your own alternate phrase. Adding an
alternate phrase ensures that the response will display for the end user, even
though the main phrase is not used.
You can also right-click in the grid and select Add Alternate Phrase from the context menu.
Opens a dialog, which lets you choose a topic or snippet, linking it to the main
phrase that is selected in the grid below. You can also choose a bookmark within
the linked file. After adding a link, the content in the linked file is shown in the
response area to the right, although it is read-only; to edit the content, you must
do so in the topic or snippet file itself. If you selected a bookmark when linking
the file, the response will include any content after the point of that bookmark in
the file. The linked file name is also shown under the main phrase when you
expand it in the grid.
After adding a link, the button changes to
, which you can click to remove the
link. In the response area to the right, the content from the linked file is converted to text.
You can also right-click in the grid and select Add Link or Remove Link/Convert
to Text from the context menu.
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Button/Section

Description
Deletes the selected phrase or alternate phrase in the grid. Use caution when
deleting a main phrase, because any associated content entered directly into
the response area (as opposed to a linked file) will also be removed.
You can also right-click in the grid and select Delete Phrase from the context
menu.
Opens the Variables dialog, which lets you insert a variable into the phrase. This
button is enabled only if you first select the phrase text (e.g., click it and press
F2) so that it can be edited.
Toggles between showing or hiding any variable definitions found in the grid. By
default, only the variable syntax is initially shown, but after clicking this button,
you will see its definition.
Expands all the phrase entries in the grid below, so that you can see any links or
alternate phrases associated with them.
Collapses all the phrase entries in the grid below, so that you can see only the
main phrases, rather than any links or alternate phrases associated with them.
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Search Filter
You can use the search filter field under the local toolbar to quickly locate a particular phrase. Clearing the filter field will again show all phrases.
EXAMPLE
Following is a micro content file containing many phrases.
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Let’s say we want to see only the phrases containing the word “topic.” In that case, we
would type topic into the search bar and the phrases would immediately be limited to
those with that word.

After removing the word “topic” from the search bar, the full set of phrases is shown
again.
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Grid
In the grid, you can do any of the following to manage your phrases and alternate phrases:
n

Expand Entry You can double-click a main phrase to expand it, thus showing any linked files or
alternate phrases below it. Alternatively, you can click to the right of the phrase, which then
changes the button to .
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n

Add Alternate Phrase To the right of the appropriate main phrase, click
. This adds a new
alternate phrase under the main phrase. Replace the generic text with your own alternate
phrase.

You can also right-click in the grid and select Add Alternate Phrase from the context menu.
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n

Delete Phrase To the right of the phrase, click . For alternate phrases, this button appears
to the right only when you hover over that alternate phrase.

You can also right-click in the grid and select Delete Phrase from the context menu.
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n

Link File to Phrase After expanding a phrase in the grid, click Add Link. In the dialog, find and
select a topic or snippet to be used as the response for that phrase. You can also choose a
bookmark within the linked file; in that case, the response will include any content after the
point of that bookmark in the file.

You can also right-click in the grid and select Add Link from the context menu.
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n

Remove Link Under the main phrase, click
. The link is removed from the phrase, but the
content in the response area to the right remains after being converted to text.

You can also right-click in the grid and select Remove Link/Convert to Text from the context
menu.
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n

Select New Link Right-click on a phrase that is linked to a file and choose Select New Link. In
the dialog, find and select a topic or snippet to be used as the response for that phrase,
instead of the currently linked file.
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n

Open Linked File Under the main phrase, click on the name of the topic or snippet that is
linked. That file opens in the XML Editor so that you can edit it.

You can also right-click in the grid and select Open Link from the context menu.
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Tips
Here are a couple of things to keep in mind when working with phrases:
n

Exactness of Phrases What if a user enters search text that is close to your micro content
phrase, but the wording is not exact? For example, maybe your phrase is “create widget” but a
user enters “creating widget.” Fortunately, Flare uses a scoring mechanism behind the scenes
that allows for slight differences between a phrase and the text entered in a search. To
account for searches that are not close enough to be handled automatically by Flare’s calculation, you should create alternate phrases. There isn’t a way to measure this beforehand;
you simply need to test your output and adjust your micro content accordingly.

n

Analytics The response part of micro content is important, because it contains the information that the reader needs. However, the initial phrase (or search term) portion of micro content is just as important, if not more so. Why? Because the response will be completely
useless if users never encounter it. It is vital that you begin with the correct phrases (or questions). So how can you be sure you are using the right phrases? You could just rely on educated guessing, or perhaps you created a glossary some time ago that gives you an idea of
what users might want to know about. But a better approach is to use analytics on your output, such as MadCap Pulse, Google Analytics, or some other resource. After looking at reports
of the most commonly used search keywords, you can create micro content with the same
phrases.
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Responses
For each micro content phrase, you need a response, which is what the end user sees after performing a search, interacting with a chatbot, etc. You can enter a response directly on the right side
of the Micro Content Editor, which works like a light version of the XML Editor. You can also use an
existing topic or snippet (or part of it) as the response by linking to it. Another method is to select
content in a topic or snippet and turn it into a micro content response. If you decide to enter content
directly into the Micro Content Editor, you can use toolbar buttons for certain features. You can also
use some options in the ribbons to insert other features (e.g., lists); the local toolbar simply contains
buttons for some of the most frequently used features.

Toolbar
Button/Section

Description
Clicking the down arrow on this button lets you select a medium or media
query so that you can view the topic with a specific set of styles.
Opens the Insert Hyperlink dialog, which lets you insert a text hyperlink on the
selected text.
Opens the Insert Cross-Reference dialog, which lets you insert a cross-reference at the location of the cursor.
Opens a dialog, if you click the face of the button. You can use this dialog to
insert an image. If you click the down arrow on the button, a drop-down opens,
where you can access your pinned images and recently used images.
Opens the Insert Snippet Link dialog, if you click the face of the button. You
can use this dialog to insert a snippet. If you click the down arrow on the button, the Insert Snippet drop-down opens, where you can access your pinned
snippets and recently used snippets.
Opens the Variables dialog, if you click the face of the button. You can use this
dialog to insert a variable. If you click the down arrow on the button, a dropdown opens, where you can access your pinned variables and recently used
variables.
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Button/Section

Description
Opens the Character dialog, if you click the face of the button. You can use this
dialog to choose a character to insert or perform many other tasks. If you click
the down arrow on the button, you can select other options, such as inserting a
quick character or choosing one of your favorite or recent characters.
Turns paragraph and space markers on and off. When you turn this feature on,
you can see markers that show where paragraphs end and where space exists
before and after content.
If you click the face of this button, all of the content changes, showing the XML
tags surrounding the content. If you click the down arrow, you can select various other options.
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Right-Click Menu
If the phrase is linked to a topic or snippet file, the response area is read-only. If you right-click on the
linked content, you can do any of the following:
n

Remove Link/Convert to Text The link is removed from the phrase, but the content in the
response area to the right remains after being converted to text.

n

Select New Link In the dialog, find and select a topic or snippet to be used as the response for
that phrase, instead of the currently linked file.
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n

Open Linked File The linked file opens in the XML Editor so that you can edit it.

Tips
Here are a few things to keep in mind when creating your response content:
n

Keep It Short Remember that micro means “small.” Flare lets you add lots of different things
to micro content (e.g., paragraphs, lists, steps, images, animated gifs, videos, links, tables),
the same kind of content you can add inside a topic. But that doesn’t mean that you should
add lots of content. Try to keep your micro content as short as possible, while not sacrificing
necessary information.
In the Skin Editor, you can set a maximum size for featured snippets in the output.
If a response exceeds the height in the output, an arrow button lets users expand and collapse
the content that is not initially shown.
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n

Responsive Structure Depending on the subject matter, you might want to structure a
response to show text on one side and something else—such as an image, animated gif, video,
or table—on the other side. If you do this, you might consider using a responsive layout for the
structure, so that the different elements stack on top of one another when viewed on a small
screen.

In the output, the image in the above example will display to the right of the steps, but on a
smart phone, the image will display below the text.
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n

To Link or Not to Link? When creating a response, you can do so in the following ways:
l

l

l

You can enter content directly in the Micro Content Editor.
You can link a phrase in the Micro Content Editor to a topic or snippet (or a bookmark
within such a file).
You can select specific content in a topic or snippet and create new micro content from
there. The phrase you create will then be linked to that specific content in the topic or
snippet.
Method

Micro Content Editor
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Pros
This method is simple. Just
start adding content in the
editor.

Cons
You don’t have as many
options as you do in a topic or
snippet. For example, you cannot add a responsive layout directly in the Micro Content
Editor, but you can copy content such as this from a topic
or snippet into that editor.
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Method
Link to Topic from Micro
Content Editor

Pros

Cons

If you already have a topic
that is suitable for micro content, you do not need to create new content, but instead
just link to the existing file.

Linking to some topics (even
using a bookmark) might be
too much content for a micro
content response.

In a topic, you can use all of
the editing features available in Flare.
You can link to the entire
topic, or to a bookmark
within it. If you link to a bookmark, the output will show all
of the content after that
bookmark, but none before
it.
A link is automatically added
to the bottom of the featured snippet in the search
results, which lets users
open the corresponding
topic on a new page.
Not only will the content display in the featured snippet
in search results, but an
abstract and link to the topic
will also appear with the rest
of the search results.
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Method
Link to Snippet from Micro
Content Editor

Pros

Cons

If you already have a snippet
that is suitable for micro content, you do not need to create new content, but instead
just link to the existing file.

Linking to some snippets
(even using a bookmark)
might be too much content
for a micro content response.

In a snippet, you can use all
of the editing features available in Flare.
You can link to the entire
snippet, or to a bookmark
within it. If you link to a bookmark, the output will show all
of the content after that
bookmark, but none before
it.
In addition to linking a snippet to a micro content
phrase, you can also reuse
the snippet in other places in
your project.
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Method

Pros

Create Micro Content from
a Topic or Snippet

If you already have a topic or
snippet that contains content that is suitable for
micro content, you do not
need to create new content,
but instead just link to the
content.

Cons
Some content contained in a
topic or snippet might look
just fine as a standalone
micro content response.
However, sometimes you
might find the need to make
edits to that content first.

In a topic or snippet, you can
use all of the editing features available in Flare.
This method lets you be
more specific with the
response than if you were to
link to a topic or snippet
from the Micro Content
Editor. You can keep the
response limited to just the
content that you choose.
If the micro content was created in a topic (as opposed
to a snippet), a link is added
to the bottom of the featured snippet in the search
results, which lets users
open the corresponding
topic on a new page.
If the micro content was created in a topic (as opposed
to a snippet), not only will
the content display in the
featured snippet in search
results, but an abstract and
link to the topic will also
appear with the search results.
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How to Add a Micro Content File to a Project
1. (Optional) Create a subfolder to store a micro content file.
a. Select View > Content Explorer.
b. In the Content Explorer, select the Resources folder.
c. In the local toolbar, click

. A folder with the temporary name "NewFolder" is added.

d. Type a new name for the folder (we recommend using MicroContent as the name) and
press Enter.
2. Right-click on your Resources > MicroContent folder (or whatever you have named it) and
from the context menu select New > Micro Content. The Add File dialog opens.
3. In the File Name field, type a new name for the micro content file.
4. Click Add. The micro content file is added to the Content Explorer. The Micro Content Editor
opens to the right, displaying micro content phrases on the left and an area to the right for the
response. There is one phrase/response already added, which you can remove or rename/replace.

NOTE: Each micro content file can hold as many phrases and responses as you need. So
you might need only one micro content file. However, you can create multiple micro content files to help organize your phrases and responses into different groups.
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How to Create Phrases and Responses in
the Micro Content Editor
1. From the Content Explorer, open the micro content file.
2. Add phrases and alternate phrases.
Main Phrase
. A new row is added to the phrase area on the
a. In the local toolbar of the editor, click
left, with "New Phrase" shown as the default name.
b. Type your phrase and press Enter on the keyboard.
Alternate Phrase
Not only can you create phrases, but you can also add alternate phrases. These are extremely
useful because it is impossible to predict the phrasing a person will use. By adding alternate
phrases, you are improving the odds that the matching response will display in most circumstances.

. A new row is added below the main phrase,
a. To the right of the main phrase, click
with "New Phrase" shown as the default name.

CHAPTER 2

42

b. Type your phrase and press Enter on the keyboard.
c. Repeat these steps to create more alternate phrases.
NOTE: The main phrase does not carry more weight than any of the alternate
phrases. They are simply a way to connect to the same response as the main phrase.

NOTE: For explanations of additional phrase options in the Micro Content Editor
(such as using variables), see "Phrases" on page 19.
3. After selecting a phrase on the left, add a response directly in the area to the right, or link to a
topic or snippet.
Use Micro Content Editor
a. In the area to the right, enter text and other features, just as you would edit a topic or
snippet.
b. Click

to save your work.

Link to Topic or Snippet
a. If necessary, click
phrase.

to the right of the main phrase. This expands the area below the

b. Click Add Link.
c. In the Select File dialog, locate and select the topic or snippet.
d. (Optional) If you want to point to a bookmark, click
mark in the dialog and click OK.

. Then find and select the book-

If you link to a bookmark, the featured snippet in the output will display all of the content
that is found after that bookmark. None of the content above it will be seen.
e. In the Select File dialog, click OK. The response content is shown to the right, but it is
read-only since it is linked. In order to edit the content, you need to edit the topic or snippet.
f. Click
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How to Create Micro Content from a Topic
or Snippet
Not only can you create micro content directly in the Micro Content Editor, but you can also do so
from a content file—a topic or snippet. The great benefit of using this approach is that you can
choose a specific block of existing content that will be used as the response.
These steps are different than linking to a topic or snippet from a micro content file. In that case,
the response would consist of the entire topic or snippet, or the content from the bookmark to the
bottom of the file, if you decide to use a bookmark. In this case, the response consists only of the
specific content in the topic or snippet that you select.
1. Open the topic or snippet.
2. Do one of the following:
n

CHAPTER 2

Select the content that you want to use as a response for a micro content phrase. Then
in the Home ribbon, click Create Micro Content.
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n

Right-click selected content, or the structure bar to the left of the content, that you
want to use as a response for a micro content phrase. From the context menu, select
Create Micro Content.

The Create Micro Content dialog opens.
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3. In the Phrase field, enter the text that a user would enter to make the response appear as a
result in the output.
NOTE: After you have finished, you can open the Micro Content Editor and add alternative phrases to be associated with the response as well.

if you want to insert a variable as the entire phrase, or as part
4. (Optional) You can also click
of the phrase. The following syntax for the variable will be used:
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5. If you have more than one micro content file in your project, use the Micro Content File field to
select it.

6. Click OK.
The micro content file will be updated with your new phrase linking to that content.
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Also, you might notice that the selected content in the topic or snippet is now wrapped in a
special MadCap:microContent tag.

7. Click

to save your work.

In the output, when a person uses your phrase (or something close to it) to look for information, the
selected content will display by itself as a result, even if the topic or snippet has other content above
or below it in the source file.
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How to Use Micro Content for Advanced
Purposes
Follow these steps if you want to use micro content in a chatbot or for another purpose that cannot
be produced completely from Flare.
1. After generating HTML5 output that includes micro content phrases and responses, you can
open the Project ribbon and click Open Output Folder.

2. In Windows, open your target folder, then double-click the MicroContent folder.
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This folder contains HTML files named after your phrases, with the associated responses contained inside.

3. At this point, a developer would need to do some extra programming and work outside of
Flare, pointing to the files in your MicroContent output folder as necessary. You might find the
need to use third-party applications as well.
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How to Enable Micro Content
1. Open an HTML5 target.
2. Select the Search tab.
3. From the Search Engine section, make sure MadCap Search or Elasticsearch is selected.
4. Expand the Advanced Search Options section.
5. Select Include micro contents results.
6. Click
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How to Control the Look and Size of Micro
Content
1. Open an HTML5 skin.
2. Select the Styles tab.
3. In the local toolbar, make sure Web Medium is selected.
4. On the left side of the editor, in the Search Results section, expand any of the following styles:
Style

Description

Search
Micro Content Result

This is the main container holding the micro content result, including the
response content, the expand/collapse button, and the link and path if the
response is a topic.

Search
Micro Content
Response

This is the container holding the micro content response.

Search
Micro Content
Response
Expand

This is the area used to expand the response (if necessary) to show more of
its content.

Search
Micro Content
Response
Collapse

This is the area used to collapse the response (if necessary) to show less of
its content.

Search
Micro Content
Response
Fade

This is the area just above the expand portion of the micro content response
(if it is too long to show it all). For example, you might want to add a color
gradient to make it more clear that additional content can be seen by
expanding the response.
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Style

Description

Search
Micro Content
Response
Link

This is the link to the associated topic (if the micro content phrase was
linked to one).

Search
Micro Content
Response
Link (active)

This is the micro content response link when it is in an active state.

Search
Micro Content
Response
Link (focus)

This is the micro content response link when it has focus.

Search
Micro Content
Response
Link (hover)

This is the micro content response link when a user hovers over it.

Search
Micro Content
Response
Link (visited)

This is the micro content response link after it has been selected.

Search
Micro Content
Response
Path

This is the path to the associated topic (if the micro content phrase was
linked to one), including any bookmark.
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5. Expand any of the nodes and complete the necessary fields. The properties and fields that
you see are different for each node. Also, you might see nodes for a Tripane skin that you do
not see for a Side or Top Navigation skin, and vice versa. Following is a general list in alphabetical order:

BACKGROUND
You can change any of the following to affect the background:
n

Gradient This lets you change the background color using a progression effect. Select
the beginning gradient color in the first field, and then select a second gradient color in
the second field. You can use any of the following to enter or select a color.
You can type a hexadecimal number (e.g., #000000) directly in this field.
Alternatively, you can click the down arrow and choose a color or make
the background transparent.
This opens the Color Picker dialog, which lets you choose a color in many
ways.
Adds a small bar above the cursor. As you move the cursor over any area
of your computer screen, the color changes in the bar to reflect the color
that is directly behind the tip of the cursor. When you click, that color is
automatically loaded into the Color Picker dialog.

n

Color This lets you select a single color.

n

Image This lets you select an image for the background. Click
select an image file.

n

Repeat Use this field to tell Flare whether the image should repeat or not.

and use the dialog to

NOTE: The Image field has the highest precedence, which means that if you enter
settings in all of the Background fields, the image will win. Gradient has the next
highest precedence. If you want to use the Color field, you need to make sure the
Gradient fields are set to transparent and that there is no image selected.
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BORDER
You can change any of the following to affect the border on the element:
n

Border Edge Fields (Top, Right, Bottom, Left) You can add a border line around any of the
edges of the element. You can use any of the following. The first three fields are used to
control the type and size of the border line. The last three fields are alternative ways to
choose a color for the border.
You can select a type of line for the border (e.g., solid, dashed, dotted).
Type a number in the field or use the arrows to increase or decrease it.
Click in this field and select a unit of measurement (e.g., pixels, points,
centimeters).
You can type a hexadecimal number (e.g., #000000) directly in this field.
Alternatively, you can click the down arrow and choose a color.
This opens the Color Picker dialog, which lets you choose a color in many
ways.
Adds a small bar above the cursor. As you move the cursor over any area
of your computer screen, the color changes in the bar to reflect the color
that is directly behind the tip of the cursor. When you click, that color is
automatically loaded into the Color Picker dialog.

n

Border Radius Fields (Top Left, Top Right, Bottom Right, Bottom Left) If you want the element to have rounded corners, you can enter values in any of these fields. In the first field
type a number or use the arrows. Then click in the second field and select the unit of
measurement (e.g., pixels, points, centimeters). The higher the number, the more of a
curve the corner will have.
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BOX SHADOW
You can change any of the following to affect the box shadow on the element:
n

Horizontal Shadow Length This is the position of the horizontal shadow. Negative values
are allowed. In the first field type a number or use the arrows. Then click in the second
field and select the unit of measurement (e.g., pixels, points, centimeters).

n

Vertical Shadow Length This is the position of the vertical shadow. Negative values are
allowed. In the first field type a number or use the arrows. Then click in the second field
and select the unit of measurement (e.g., pixels, points, centimeters).

n

Shadow Blur Length This is the blur distance. In the first field type a number or use the
arrows. Then click in the second field and select the unit of measurement (e.g., pixels,
points, centimeters).

n

Shadow Color This lets you select a color for the shadow. You can use any of the following:
You can type a hexadecimal number (e.g., #000000) directly in this field.
Alternatively, you can click the down arrow and choose a color or make
the background transparent.
This opens the Color Picker dialog, which lets you choose a color in many
ways.
Adds a small bar above the cursor. As you move the cursor over any area
of your computer screen, the color changes in the bar to reflect the color
that is directly behind the tip of the cursor. When you click, that color is
automatically loaded into the Color Picker dialog.

n

Shadow Insert This changes the shadow from an outer shadow (outset) to an inner
shadow. Click in the field and select an option. If you select false the shadow will be outset. If you select true the shadow will be inset.
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FONT
You can change any of the following to affect the font:
n

Color This lets you select a color for the font. You can use any of the following:
You can type a hexadecimal number (e.g., #000000) directly in this field.
Alternatively, you can click the down arrow and choose a color.
This opens the Color Picker dialog, which lets you choose a color in many
ways.
Adds a small bar above the cursor. As you move the cursor over any area
of your computer screen, the color changes in the bar to reflect the color
that is directly behind the tip of the cursor. When you click, that color is
automatically loaded into the Color Picker dialog.

n

Family You can select or type a specific font family (e.g., Arial, Tahoma, Verdana).

n

Size You can change the font size. In the first field type a number or use the arrows. Then
click in the second field and select the unit of measurement (e.g., pixels, points).

n

Weight You can click in this field and make the font normal or bold.

n

Style You can change click in this field and make the font normal or italic.

HEIGHT
You enter a height for the element. In the first field type a number or use the arrows. Then
click in the second field and select the unit of measurement (e.g., pixels, points, centimeters).

LAYOUT
You can click in the Display field and choose whether to show the element (block) or not
(none).

MARGIN
You can change the margin for any of the sides on the element (Left, Right, Top, Bottom). In
the first field type a number or use the arrows. Then click in the second field and select the
unit of measurement (e.g., pixels, points, centimeters).

CHAPTER 2

57

PADDING
You can change the padding for any of the sides on the element (Left, Right, Top, Bottom). In
the first field type a number or use the arrows. Then click in the second field and select the
unit of measurement (e.g., pixels, points, centimeters).

SIZE
You can change the height or width of the element. In the first field type a number or use the
arrows. Then click in the second field and select the unit of measurement (e.g., pixels, points,
centimeters).

TEXT DECORATION
You can click in the Decoration field and select a text decoration (e.g., underline, line-through,
overline, underline).
6. Click
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Micro Content and Glossary Terms
If you have a glossary term that is the same as a micro content phrase, both will be displayed in the
output. The micro content featured snippet will be on top, with the glossary term following it.
Depending on how similar the content is between them, you might decide to remove one of them so
that you are not displaying duplicate information to end users.
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Micro Content Reports
You can run reports to find the following types of information about micro content:
n

Duplicate Micro Content Phrases

n

Files with Micro Content Links

n

Micro Content Empty Phrases

n

Micro Content Empty Repsonses
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What the MadCap Doc Team Does
We currently do not use micro content for chatbots or other applications that require extra programming outside of a Flare project. However, we do use micro content extensively for featured
snippets in search results of the output. Our approach involves the following:
n

Analytics Our online output is integrated with MadCap Pulse, which gives us access to various
reports. We sort the Search Phrases report to see which terms end users are entering most
often for searches. Based on these results, we create our micro content phrases and alternate phrases in the Flare project.
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n

Number of Micro Content Files Based on the search phrases we noticed in our Pulse reports,
we decided to make three micro content files, storing them in a Resources > MicroContent
subfolder:
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l

Quick Steps First, we noticed phrases containing verbs (e.g., apply condition tag, import
Word), indicating that users are trying to find information on how to complete a specific
task. Therefore, we created a micro content file and named it “Quick-Steps.” The
response for each of these micro content phrases is a very brief set of steps, usually a
shortened version of the main topic for that task.
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l

Mini Landing Pages We discovered that the vast majority of search phrases in our reports
are simply words or short phrases (e.g., skin, master pages, output), rather than actual
questions or even phrases containing a verb. Therefore, we created a second micro content file and named it “Mini-Landing-Pages.” Since these search phrases are somewhat
vague (e.g., if people search for “skin,” we don’t know which aspect of skins they want to
know about), the responses associated with the micro content phrases are designed to
be mini landing pages, containing a short snapshot of the subject with links to the tasks or
other information that we think the user is most likely trying to find. These mini landing
pages are essentially much smaller versions of the large landing pages that exist for most
features in our documentation.
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l

Related Questions Finally, some of our mini landing pages seemed to require more content than we wanted to display normally in a micro content response. In other words,
there were more gaps that we needed to fill when attempting to discern what information users are actually after. A good example for us is the phrase "styles," which is such a
large subject that it's difficult to know what information to include or exclude in the micro
content response.
One of the SERP features that you see in Google sometimes is called "Related Questions"
(or "People Also Ask"). This object is a collection of drop-downs with common questions
and answers for a big subject.
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We used drop-downs as part of our micro content responses to mimic this behavior for
our really big subjects, such as styles, output, and tables of contents. It's not exactly the
same as Google's Related Questions feature, but it serves essentially the same purpose.
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n

Structure and Style of Responses We wanted to include both text and either multimedia or
images in most of our micro content responses. With text usually appearing on the left or top,
and the multimedia or image on the right or bottom, we decided to create a few different
responsive layouts; this allows the content to stack when viewed on a small screen. We also
created a couple of unique styles that are used only for our micro content responses because
we wanted the content to use as little space as possible in the search results (e.g., smaller
font, less space between items in a list).
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n

Skin Styles As far as the skin is concerned, we used the default settings for most areas of the
micro content. However, we did make a few changes.
First, we decided to increase the height of the responses because most of our content was
requiring users to click the expand button to see all of the information. So on the Styles tab of
the Skin Editor, we expanded Search Micro Content Response > Size, and we changed the
default Maximum Height from 200 px to 400 px. Although some of our micro content
responses still require users to use the expand function to see everything, the majority of our
responses can now be seen without doing this on a large screen.
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Before the Change

After the Change
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Also, since we don't have links or paths to topics at the bottom of our responses, we decided
to remove the bottom border for Search Micro Content Response Expand. This helps us avoid
the look of a double border when there are responses that need to be expanded.
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So when we have a response that needs to be expanded to see more, the bottom of that
response no longer looks like this:
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But instead it looks like this:
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n

Response Links to Snippets We do not use the Micro Content Editor to enter our content. The
primary reason is that this editor does not allow us to insert responsive layouts directly, and
those layouts are an integral part of our responses. We also decided not to link to full topics
because they are typically too long for micro content responses. We considered creating
micro content from selected content in existing topics—and we might still do that for some
future micro content that we create—but doing that with our initial collection of micro content
would have required more customization of existing content than we wanted. In the end, we
decided the most streamlined solution for us was to create unique snippets that are designed
to be condensed versions of our big landing pages or large task topics, and then we linked our
phrases to those snippets from the Micro Content Editor.
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NOTE: If you test the micro content in your output and notice that searching on one
phrase is opening the results for a different phrase, you might want to see if you have a
synonym set up that is causing the issue. For example, you might have previously added
"iPhone" as a synonym for "telephone." Then in a micro content file, you add "iPhone" and
"telephone" as separate phrases. When users search for iPhone in the output, they will see
the results for telephone instead. If this occurs for you, you might want to remove that
entry in your synonym file. If this does not solve your issue, please contact Technical Support.
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CHAPTER 3

CSS Variables
Variables have always been available for use with content in Flare, and now they are also available
with styles to enhance your single-sourcing. These are called “CSS variables.”
A CSS variable lets you place the value for a style in one place and reuse it throughout a stylesheet.
As with other kinds of single-sourcing, this can help with speed, ease of use, and consistency.
Whenever you want to change the value, you only need to do so in one place and the new value is
propagated everywhere that the variable is referenced. You certainly could use the "find and
replace" feature instead to change the value, but CSS variables are preferred because you won’t
need to worry about inconsistencies in your stylesheet. For example, some values—such as colors—
can be written in various ways, so in those cases CSS variables make a lot of sense.
Of course, color isn't the only place where you can use CSS variables; they can be used for all kinds
of properties. But color might be where CSS variables are most commonly seen, so in this section
we are mainly using color to illustrate how CSS variables work.
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Basics of CSS Variables
You can easily spot a CSS variable. It is any property that begins with two dashes.
--my-css-variable: green;
A CSS variable is sometimes called a “custom variable” because you can use whatever name you
want (but don’t use spaces), rather than always adhering to standard CSS property names such as
“color,” “width,” and “font-size.” For example, you might have a CSS variable written like this in order
to identify your company’s primary branding color:
--main-company-color: #bed420;
When a CSS variable is referenced by another property, it is done so with the var() function.
color: var(--main-company-color);
You can define a CSS variable either locally or globally. A locally defined CSS variable is set on a particular selector.
.banner-text
{
--main-company-color: #bed420;
}
On the other hand, a globally defined CSS variable is set on the :root selector.
:root
{
--main-company-color: #bed420;
}
Most of the time you will probably use the :root selector for your CSS variables. It’s a good way to
group all of your CSS variables in one place. Also, the variables become available throughout the
stylesheet and content files (i.e., the variables are global).
Following are a few other important considerations of CSS variables:
n

Normal rules of inheritance and cascading apply to CSS variables.

n

They are case-sensitive, so make sure you are consistent when creating and using them.

n

You can change the value under @media sections in order to override the value on the default
medium.
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EXAMPLE
You might have the following set in the default medium:
:root
{
--main-company-color: #bed420;
}
But then you have this under the @tablet media query:
@media tablet
{
:root
{
--main-company-color: #1c5a97;
}
}
As expected, the color will change from green to blue once the screen size is
reduced to a tablet.

NOTE: For more detailed information about CSS variables, you can refer to numerous thirdparty websites on the Internet.

EXAMPLE
Let’s say you have three fonts that you use throughout your stylesheet: Roboto Light,
Roboto Medium, and Roboto Dark. Instead of setting these specific fonts in all those
places, you decide to create three CSS variables for each of these: LightFont, MediumFont, DarkFont.
To start, you add these three CSS variables on the :root HTML element.
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Next, you insert each of these CSS variables, where appropriate, on properties throughout the stylesheet.
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A year later, your company decides to change the font families from Roboto to Segoe
UI. Therefore, you open the stylesheet, navigate to (Variables) > :root and change the
values for the three CSS variables.

You don’t need to do anything else. You will see that all of the styles pointing to these
CSS variables are updated automatically when you generate the output.
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How to Create a CSS Variable
1. From the Content Explorer, open the stylesheet that you want to modify.
2. In the local toolbar, click the CSS Variable down arrow and select Add New CSS Variable.

The Add New CSS Variable dialog opens.
3. Complete the fields:
n

HTML Element By default this field is populated with :root for new CSS variables. This is
probably what you will use most of the time so that the variable is global. But you can
replace this with a specific selector (e.g., p, ol, img) if you want.

n

Name Enter a name for the variable.

n

Property Type Select a property to associate with the variable. The most common property types are listed, but you can also choose “(Custom)” if you need something other
than the options shown.

n

Value Enter a value that is appropriate for the variable, based on the property type you
selected.

n

Resulting CSS As you complete the fields above, this field shows how the variable will
appear in the stylesheet. If you forgot to add two dashes in front of the variable name,
Flare adds them automatically in this field (e.g., --Brand: #6be42e).
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4. Click OK. The new CSS variable is added to the stylesheet. It can be found in the Advanced
View of the Stylesheet Editor in the (Variables) section. Make sure All Styles is selected in the
filter field in order to see it.
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If you set a CSS variable on a regular selector (rather than :root), it will also be seen under that
section.

5. Click
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How to Insert (Use) a CSS Variable
1. From the Content Explorer, open the stylesheet that you want to modify.
2. In the local toolbar, make sure the first button displays

. If the button displays

instead, then click it.
3. Locate and select a style and property where you want to use the CSS variable. In the grid, all
you need to do is select the appropriate row for that property.

NOTE: If you have a property that already contains a value and you want to add a
CSS variable next to it, selecting the property row and using the following steps will
overwrite the other value. However, you can easily work around this limitation by clicking in the value cell and simply typing the CSS variable syntax next to the existing
other value(s).
For example, the following border-left property already has 2px solid as the value. So
if you want to insert a CSS variable called "--Light-Gray2" next to it, you would type it
like this:

CHAPTER 3

84

4. In the local toolbar, click the CSS Variable down arrow and select Insert CSS Variable.

The Insert CSS Variable dialog opens.
5. From the drop-down, select the CSS variable you want to insert.

6. Click OK. The property field changes, showing “var” followed by the name of the CSS variable
in parentheses.

7. Click
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How to Edit a CSS Variable
1. From the Content Explorer, open the stylesheet that you want to modify.
2. In the local toolbar, make sure the first button displays

. If the button displays

instead, then click it.
3. In the upper-left of the editor, make sure the drop-down field is set to
.
4. On the left side of the editor, expand (Variables).
5. Click the HTML element with the CSS variable you want to edit. Most of the time this will probably be :root, but it might be a specific selector.
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6. From the Show drop-down list on the upper-right side of the editor, select
This displays only the properties that have been set for that particular selector.

.

7. (Optional) You can use the toggle button in the local toolbar to show properties below in a
group view
or an alphabetical view
. If it is in group view, expand Variables to see the
variables under it.
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8. If you only want to change the property value, you can click in the row and type it. Otherwise,
on the right side of the row (variable) you want to edit, click . The Edit CSS Variable dialog
opens.

9. You can change any of the fields in the Edit CSS Variable dialog:
n

HTML Element By default this field is populated with :root for new CSS variables. This is
probably what you will use most of the time so that the variable is global. But you can
replace this with a specific selector (e.g., p, ol, img) if you want.

n

Name Enter a name for the variable.

n

Property Type Select a property to associate with the variable. The most common property types are listed, but you can also choose “(Custom)” if you need something other
than the options shown.

n

Value Enter a value that is appropriate for the variable, based on the property type you
selected.

n

Resulting CSS As you complete the fields above, this field shows how the variable will
appear in the stylesheet. If you forgot to add two dashes in front of the variable name,
Flare adds them automatically in this field (e.g., --Brand: #6be42e).

10. Click OK.
11. Click
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Resolving CSS Variables for Internet
Explorer
Unfortunately, CSS variables are not supported in Internet Explorer. However, there is an option on
the Advanced tab of the Target Editor that you can enable to correct this.
When you enable this feature, the CSS variable will be replaced with the actual value in the output.
In other words, you will not see the var(--[VariableName]) instance. However, this will be done only if
the CSS variable is declared in the :root or html selector.
EXAMPLE
Let's say you create a CSS variable on the :root selector and you name it "--Brand." On
this variable, you set the color #bed420. Then, you insert that variable into the color
property for your h1 style.
If you do not enable the option to resolve CSS variables, the color will not be seen in the
topic in Internet Explorer. And if you inspect that topic in the output (e.g., right click on
the topic and select Inspect element), you will see this:
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But if you do enable the option, the color will be seen in the topic in Internet Explorer.
And it will look like this if you inspect the topic:
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HOW TO RESOLVE CSS VARIABLES
1. Open an HTML5 target.
2. Select the Advanced tab.
3. Select Resolve CSS variables (required for IE compatibility).

4. Click

to save your work.

NOTE: This option is not included in Eclipse and HTML Help targets, because the feature is
always enabled for those outputs.
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CHAPTER 4

Zendesk Plug-In
This plug-in allows you to publish Flare output to your Zendesk Help Center dashboard. This is beneficial if you have a knowledge base or FAQ that supports any service desk tickets on your dashboard.
You can publish directly to categories and sections you have created in Zendesk.
You have the option to install the plug-in when you install or upgrade Flare. The Madcap Connect
plug-in for Zendesk supports outputs using Clean XHTML and skinless HTML5 outputs.
Zendesk provides multilingual support to publish your articles.
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Best Practices for Publishing to Zendesk
The following list provides some best practices and guidelines as you configure Zendesk Help
Center prior to publishing your output. These guidelines can help when structuring the TOC, and configuring the destination file being used for Zendesk.
n

It is recommended you create a separate table of contents (TOC) to publish output to
Zendesk.

n

You can use the initial categories and sections created in Zendesk Help Center if it aligns with
the TOC you are using for publishing. Otherwise, you can create your own categories and sections in Zendesk for better alignment with your TOC.

n

In the Destination Editor, the Use TOC to define setting should be enabled if the TOC has several nested levels. Otherwise, all topics from that TOC are published as articles to the default
category and section.

n

In the Target Editor, enable the setting on the Advanced tab labeled Exclude content not
linked directly or indirectly from the target. This prevents all of the content in your project
from being published. Only the content specified in the TOC for your target is published.

n

You should limit publishing multiple targets to Zendesk in the same batch to avoid any
API rate limitations during the upload process. For more information, see the following:
https://develop.zendesk.com/hc/en-us/articles/360001074328-Best-practices-for-avoidingrate-limiting

n

The attachment limits for uploading to Zendesk are 20 MB for images and other attachments
(e.g., videos) per article.
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How to Install Zendesk Plug-In
1. When you install Flare, choose Custom as the type of installation. Click Next.
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2. On the next page of the installation wizard, select MadCap Connect for Zendesk. Click Next.

3. Click Install.
4. After the Flare installation is completed, open your project and create the destination file for
Zendesk.
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Configuring the TOC for the Zendesk Help
Center Dashboard
When you first activate your Zendesk dashboard, there are default categories and sections already
created. You can use these categories and sections if it aligns with the TOC you are using to publish
to Zendesk. Otherwise, you should create your own categories and sections that better align with
your TOC.
If you are using the TOC to define your categories and sections in Zendesk, keep the following rules
in mind:
n

The top-level books in your TOC are converted to categories alongside any categories already
created.

n

Topics that are linked to top-level books are published to the default category and section.

n

Top-level topics are published to the default category and section. No additional categories
are created for the top-level topics.

n

Secondary level topics are converted to sections.

n

Any topics linked to second-level books in your TOC are published as articles to that section.

If you are using the TOC to define your sections, keep these rules in mind:
n

Top-level books in your TOC are converted to sections.

n

Topics that are linked to top-level books are published as articles in that section.

n

Top-level topics are converted into sections and also included as articles in that newly created section.

n

Second-level, lower-level books, and topics in your TOC are published as articles in the section
created by the parent book.

Other considerations to keep in mind:
n

Any topics that are not in the TOC—regardless if they are linked to topics in the TOC—are published to the default category and section configured in the destination file.

n

Any topics that reside in the third level or lower in your TOC will be published as articles on the
same level in Zendesk. This is because there are only three levels in Zendesk: categories, sections, and articles.
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n

Any categories and sections that are generated during publishing are added to Zendesk Help
Center in the same order they are displayed in the TOC. This also applies to multilingual projects.

n

If the Use TOC to define option is not checked in the destination file, all topics are published to
the designated category and section in the destination editor.

n

You can use unlinked books in your TOC to mimic the categories and sections you are using
for Zendesk.
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How to Create a Destination File for
Zendesk
1. Open the Project Organizer.
2. Right-click the Destinations folder and select Add Destination. The Add File dialog opens.
3. In the Source area select one of the following:
n

New from template Choose either the factory template file or one of your own customized template files as a starting point. The new file will take on all of the settings contained in the template. If you want to use the factory template provided by Flare, expand
the Factory Templates folder and click on a template file. If you want to use your own customized template file, expand the appropriate folder and click on a file. For more information about templates, see the online Help.

n

New from existing Choose an existing file of the same type as a starting point for your
new file. As with template files, your new file will take on all of the settings contained in
the file you select. To use this option, click the browse button
, use the Open File dialog to find a file, and double-click it.

4. (Optional) If you want to place the file into a subfolder previously created in the Content
Explorer or Project Organizer, in the Folder field click
and select the subfolder. Otherwise,
keep the default location.
5. In the File Name field, type a new name for the destination.
6. Click Add. The destination is added to the Project Organizer, and opens in the Destination
Editor.
7. In the Type drop-down field, select MadCap Connect for Zendesk.
8. Click the Activate button.
a. Enter the license key you were given with your copy of MadCap Connect for Zendesk.
b. Click Next.
c. Enter your information:
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First Name Enter the first name of the user associated with the license key.

n

Last Name Enter the last name of the user associated with the license key.

n

Email Enter the email address associated with the license key.
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d. Click Next.
e. Select either Internet Activation or Manual Activation.
n

If you chose Manual Activation, follow the instructions on-screen to copy and
paste the information in an email to customerservice@madcapsoftware.com.

f. Click Next.
g. If you chose Internet Activation, you will receive a confirmation that your MadCap Connect to Zendesk license has been activated. Click Finish.
NOTE: A message displays below the Type field indicating the status of your MadCap
Connect plug-in for Zendesk license key. You can click the Deactivate button to disconnect your license key for this plug-in.
9. In the Credentials section, click Login Credentials. This will enable you to connect to your
Zendesk dashboard.
a. Enter the Zendesk subdomain where you will be publishing your content.
b. Click Next.
c. Enter the Email address that is registered for the Zendesk account.
d. Enter the Password for the Zendesk account.
e. Click the Sign in button.
10. After connecting to your Zendesk account, set the following options in the MadCap Connect
for Zendesk section.
n

URL Displays the name of the domain used for publishing on zendesk.com. This field is
populated by the subdomain field that is entered when you login to Zendesk.

n

Use TOC to define Select this to structure your content by Categories and Sections, or
just Sections.

n

Default category Select a category that has been created in your Zendesk dashboard to
be used for publishing.

n

Default section Select a section that has been created under the category you selected
to be used for publishing.
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n

Exclusions List any files to be excluded from the published content. This might include
files such as Default.htm that are generated by Flare during the build and publish processes.

n

Preserve unsafe HTML Select this to include unsafe HTML attributes and tags in published articles. This setting is required if you want to include multimedia files, or any
other files that contain attributes that Zendesk might label as unsafe. For more information on what Zendesk considers safe HTML tags, see the following:
https://support.zendesk.com/hc/en-us/articles/115015895948-Allowing-unsafeHTML-in-articles

n

Publish articles Select this to publish your articles in Zendesk. If this option is not
checked, the articles will be published in draft mode in Zendesk. When this setting is
enabled, the following publishing options become available:
l

Use keywords for labels Use existing index keywords as labels on your published content.

l

Use concepts for labels Use existing concepts as labels on your published content.

l

Default labels Provide keywords to be used as default labels on all published content.
NOTE: The use of concept and index keywords as labels are currently not supported in Clean XHTML targets, only HTML5 targets.

11. In the View URL field, provide the location where your Zendesk output should be viewed after
it is published.
12. In the Upload section, select Upload Log File to have it published with the rest of your content
in Zendesk.
n

Upload Only Changed Files Select this to only upload updated files.
NOTE: When this option is unchecked for Zendesk, the Flare build log displays
both the changed and unchanged files being republished. However, no new
time stamp is displayed for the unchanged files in Zendesk Help Center.

n

13. Click
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Remove Stale Files Select this to remove any unchanged files. This will archive files in
Zendesk.
to save your work.
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How to Publish to Zendesk
It is recommended that you create a separate TOC and target for Zendesk before you publish your
content. You should also confirm that your destination file has been configured for Zendesk before
publishing.
1. In Zendesk, go to Settings > Guide settings.
2. Select Spam filter.
3. Select Display unsafe content. This is necessary if you wish to publish multimedia files to
Zendesk.
4. Click the Update button in the upper-right corner.
5. Open your target, which should use either the Clean XHTML or a skinless HTML5 format.
6. Set the TOC you are using for Zendesk as the master TOC in the Target Editor.
7. Click the Publishing tab, and select the destination file you created for Zendesk.
8. Click the Advanced tab, and select Exclude content not linked directory or indirectly from the
target.
9. Click

to save your work.

10. Click Publish. If you have not built the updated target, you will be prompted to build before publishing.
11. When the publish is completed, review your content in the Zendesk Help Center.

NOTE: The MadCap Connect plug-in to Zendesk must be activated through your destination file before you publish. Otherwise, your attempts to publish to Zendesk will fail.

NOTE: If you are using the same topic multiple times in the TOC, that topic is published only
once in Zendesk.
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NOTE: If you remove topics from a TOC and republish that project to Zendesk, those corresponding articles are removed from the dashboard. However, an empty section might
remain on the dashboard if all underlying articles have been removed. The empty section
needs to be manually removed through your Zendesk dashboard.

NOTE: During the build and publish processes, you may see messages in the Builds pane
about category and section translations in the Compile Status column. These messages
are a function of the Zendesk publishing process, and are displayed even if there are no
translated files. These messages are also displayed in the build log when the publish is completed.
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How to Install Zendesk Themes
When your output is published to Zendesk, a zip file is created that contains all of the styles and
JavaScript files needed to support your theme in Zendesk. The easiest way to export the theme created in the Zendesk output is to drag and drop it from Windows Explorer into your Zendesk Help
Center dashboard.
1. Build and publish your target.
2. In Windows Explorer, copy the theme's zip file that is created during publishing. This file is
found in the same location as the target's output folder. The naming convention of this zip file
is MadCap.[target_name].Theme.zip.
3. In your Zendesk Help Center dashboard, click the icon to customize the design. The Themes
page is displayed.
4. Drag your theme's zip file from Windows Explorer, and drop it into the Zendesk themes page.
Your project theme is added to Zendesk.
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5. Set the theme that was just added to a Live status.
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How to Modify Customized Themes in
Zendesk
If a theme has been customized in Zendesk, those customizations are not retained if you use the
Zendesk theme auto-generated by Flare during publishing. If you would like to keep your previous
customizations, you will need to edit the theme code in Zendesk.
1. After your target has been published, go to Windows Explorer and navigate to the folder where
your Zendesk output resides.
2. In your Zendesk Help Center dashboard, click the icon to customize the design. The Themes
page is displayed.
3. Hover over the customized theme, and click View Theme.
4. Click Edit Code.

5. Add all files from the assets folder from your Flare project's output folder to Zendesk.
6. In the templates subfolder of your theme, open the document_head.hbs file in a text editor.
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7. If you added, deleted, or renamed any of the links listed in this file, update the respective links.
n

If you added any new CSS files, add a new <link> tag for each new file.

n

If you added any new JavaScript files, add a new <script> tag for each new file.

8. Save the changes in the document_head.hbs file.
9. Click Publish in the top-right corner in the Zendesk Themes page.

NOTE: For more information on working with themes in Zendesk, please refer to the
Zendesk documentation.
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Language Support
Zendesk offers multilingual support. You can publish your output to Zendesk in the following languages supported by Flare.

TABLE OF SUPPORTED LANGUAGES
Languages Supported in Zendesk
Arabic

English (New Zealand)

Greek

Portuguese

Arabic (Egypt)

English (Phillipines)

Hebrew

Portuguese (Brazil)

Bulgarian

English (South Africa)

Hindi

Romanian

Catalan

English (United Kingdom)

Hungarian

Russian

Chinese (China)

Estonian

Icelandic

Serbian

Chinese (Hong Kong)

Filipino

Indonesian

Slovak

Chinese (Taiwan)

Finnish

Italian

Slovenian

Croatian

French

Japanese

Spanish

Czech

French (Belgium)

Korean

Spanish (Mexico)

Danish

French (Canada)

Latvian

Spanish (Spain)

Dutch

French (France)

Lithuanian

Swedish

English

French (Switzerland)

Malay

Thai

English (Australia)

German

Norwegian

Turkish

English (Canada)

German (Austria)

Persian

Ukranian

English (Ireland)

German (Switzerland)

Polish

Vietnamese
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HOW TO SET THE LANGUAGE FOR ZENDESK OUTPUT
1. Open your target.
2. Click the Language tab.
3. Click the drop-down in the Language field and select the language you wish to use in your output.
4. Click Publish.
5. After you publish your output to Zendesk, go to your Zendesk Help Center dashboard.
6. Go to your account settings in Zendesk.
7. In the Zendesk account settings, click the Localization tab.
8. In the Languages section, click the drop-down arrow to select another language.

9. Click Save tab.
10. In Zendesk Help Center, click Guide settings.
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11. Click the drop-down arrow in the Language section to apply the language to be used for your
Zendesk dashboard.

12. In the upper-right corner, click Update.

NOTE: For each language used to publish your project, you need to set up the default categories and sections for each language in Zendesk.
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EXAMPLE—U SING THE TOC TO DEFINE CATEGORIES AND SECTIONS
Let's say we want to publish our full project to Zendesk. We want to use the option to
use the TOC of our project to define both the categories and sections in Zendesk.
First, we ensure that our Zendesk dashboard is configured to reflect what we want published. For this project, we want to create categories for Knowledge Base and Support.

If we are publishing to both categories and sections, we need to create a section prior
to publishing. Therefore, we create a section under the Knowledge Base category titled
FAQ.

In the Zendesk guide settings, we ensure that the Help Center is activated.
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Next, we enable the spam filter.

We select the option to display unsafe content if we are publishing multimedia.
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In Flare, we ensure that the destination file is configured to use the TOC to define categories and sections.

The last step prior to publishing is to check that our TOC is structured to publish the topics to the category and section designated. In this case, we want the contents of our
TOC to be published directly under the category and section we set in the destination
file. We can use unlinked books in our TOC to mimic the structure of the category and
section we are using for Zendesk.
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NOTE: Keep in mind that any top-level books in the TOC are converted into categories besides any existing categories in Zendesk.
Then, we publish to Zendesk Help Center. We then review our Zendesk Help Center
dashboard to confirm that the output has been successfully published to the category
and section designated in the destination file.
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EXAMPLE—U SING THE TOC TO DEFINE SECTIONS ONLY
Let's say we want to publish a project containing system requirements to Zendesk. The
topics for system requirements comprise only a portion of our project, so we want to
use the option to define the section for the system requirements in Zendesk.
So, under the Support category we create the System Requirements section.

In the guide settings, we activate the help center if it has not been activated already.
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Next, we enable the spam filter.

We select the option to display unsafe content if we are publishing multimedia.
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Next, in Flare we configure the destination file to define our Sections. We still have to
select both the default category and the default section, even though we are only structuring by sections. The sections will be created under the default category defined in
the destination file.

We review our TOC prior to publishing. In this case, we have all of our topics on the top
level.

Then we publish our output. When we view the output in Zendesk, notice that new sections have been created based on the topics in the TOC.
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If we structure our TOC to have one top-level book with the other topics under this
book, then the published output is structured differently in Zendesk.
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EXAMPLE—NOT STRU C TU RING YOU R TOC
Say that we have designated Knowledge Base as our default category, and FAQ as our
default section. But we have decided not to structure the TOC in our destination file.

This is what our TOC looks like prior to publishing:

When we publish our Zendesk output, these topics are published as articles in the
default category and section. But notice that these articles are published on the same
level in the FAQ section, and do not mimic the nested levels that were used in the TOC.
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When the Use TOC to define option is unchecked in the destination file, the topics are
always published as articles on the same level in the default category and section.

WARNING: If you are using the MadCap Connect plug-in for Zendesk in trial mode, be
careful when publishing to a live production environment. Users in trial mode are limited to
publishing a maximum of 10 files. When you are sharing the same Flare project and
Zendesk domain with other users, any files that were previously published from Flare by
other users are archived.

NOTE: Zendesk does not support Internet Explorer.

NOTE: You cannot use any search engines used by your Flare output in Zendesk, since
none of the search data files are published. Zendesk uses their own search capabilities.

NOTE: Clean XHTML and skinless HTML5 targets are the recommended methods to publish to Zendesk. Other skin or target types are not fully supported for publishing to
Zendesk.
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CHAPTER 5

Additional Features
These are additional new features added to this release.
This chapter discusses the following:
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Chinese User Interface in Flare

121

Elasticsearch Enhancements

122

Interface Themes Updated

129

Project Templates Streamlined and Updated

131

Start Page Redesigned

137

Stylesheet Editor—Ellipsis Button for Editing Values
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Chinese User Interface in Flare
There is a new option to render the user interface in Chinese. When you launch Flare, a dialog displays asking you to select your UI Language. Select the option for Chinese from the drop-down list in
this dialog.

If this dialog does not display when you open Flare, you may need to configure this setting in the
Options dialog. Just select View > Options. Select the General tab, and enable Show Select UI Language Dialog on Startup. Then close and re-launch Flare.
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Elasticsearch Enhancements
The Elasticsearch method allows you to manage your search results through the Content Services
Portal. Now you can sort the columns displayed in the main portal window by date and by search
count. In addition, you can also view the micro content created on your output.

Changes to Content Services Portal
When you launch Content Services from the Target Editor, the Summary window opens. This information is for the specific target you are viewing in the Target Editor.
The purple box is now displayed on this Summary window for Micro Content created on the target.
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The All Targets window displays all of your targets that use Elasticsearch. There are four columns
you can sort in this window: Project, Target, Date Created, and Date Modified.

When you click again on a column you already sorted, it reverses the order the data is presented.
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On the Topics window, you now have the option to delete all topic search data from the target you
are viewing in the Content Services Portal. This should only be used if you no longer need search
data for these topics.
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When you click the purple box in the portal, the Micro Content window displays all of the phrases
and the corresponding content that responds to each phrase. Each box in this window contains the
phrase, the date the micro content was created, and its corresponding response.
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When you review the user searches, this window now provides the search date of the corresponding
search input. You can sort these results by search input, date, or the IP address where the search
was entered.
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The Global Searches window displays the search input string entered on the Elasticsearch output,
along with the date that string was last searched. This window also provides the search count to
aggregate the number of times the related search input has been entered. You can sort any of the
columns in this window in ascending or descending order.
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Changes to Elasticsearch Installation
One of the prerequisites prior to using Elasticsearch on your output is to install Java SE Development Kit (JDK) on the hosting server. Previously, Oracle provided a free JDK license that you
could install, which allowed you to view your Elasticsearch output. As of January 2019, Oracle is now
charging license fees to use their JDK. Therefore, we now provide support for a free alternative to
the Oracle JDK. This can be used to support Elasticsearch on both local searches and remote
searches made through the Content Services Portal. See the following link:
https://www.madcapsoftware.com/downloads/java.aspx
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Interface Themes Updated
The black, classic, and silver interface themes have been redesigned.
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Project Templates Streamlined and Updated
The library of project templates in Flare has been streamlined and most designs have been updated.
When you create a new project, you have access to the following online and print-based templates:
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ONLINE TEMPLATES
Template
Knowledge
Base

Side Navigation

Top Navigation

Tripane
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Characteristics
n

Contains starter topics and other files designed for an online knowledge base
in HTML5 format. If you intend to use Flare to generate an online knowledge
base, this project demonstrates one approach you may consider.

n

Includes responsive output, which means the content display changes automatically depending on the width of the screen.

n

Contains starter topics and other files intended for online HTML5 output that
looks like a modern website with navigation on the side (left or right).

n

Offers a frameless, modern alternative to the more traditional tripane
format.

n

Includes responsive output, which means the content display changes automatically depending on the width of the screen.

n

Contains starter topics and other files intended for online HTML5 output that
looks like a modern website with navigation on the top.

n

Offers a frameless, modern alternative to the more traditional tripane
format.

n

Includes responsive output, which means the content display changes automatically depending on the width of the screen.

n

Contains starter topics and other files intended for online HTML5 output in a
traditional tripane format (navigation pane, toolbar pane, content pane).

n

Includes responsive output, which means the content display changes automatically depending on the width of the screen.
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ONLINE AND PRINT TEMPLATES
Template
Side Navigation
and PDF

Top Navigation
and PDF

Tripane
and PDF
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Characteristics
n

Contains starter topics and other files intended for both online and printbased output.

n

The online HTML5 output looks like a modern website with navigation on the
side (left or right). Offers a frameless, modern alternative to the more traditional tripane format. Includes responsive output, which means the content
display changes automatically depending on the width of the screen.

n

The PDF output is a user guide that includes auto-generation of a TOC, glossary, and index.

n

Contains starter topics and other files intended for both online and printbased output.

n

The online HTML5 output looks like a modern website with navigation on the
top. Offers a frameless, modern alternative to the more traditional tripane
format. Includes responsive output, which means the content display
changes automatically depending on the width of the screen.

n

The PDF output is a user guide that includes auto-generation of a TOC, glossary, and index.

n

Contains starter topics and other files intended for both online and printbased output.

n

The online HTML5 output uses a traditional tripane format (navigation pane,
toolbar pane, content pane). Includes responsive output, which means the
content display changes automatically depending on the width of the screen.

n

The PDF output is a user guide that includes auto-generation of a TOC, glossary, and index.
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PRINT TEMPLATES
Template

Characteristics

Brochure

n

Contains two topics and two page layouts designed to create a brochure with three panes.

Policies and Procedures

n

Contains starter topics and other files designed to produce a policies
and procedures manual in PDF format.

n

Includes content and variables that you can re-use.

n

Includes auto-generation of a TOC and index.

n

Contains two topics and two page layouts designed to create a fourpane PDF product foldout.

n

Ideal for brief product instructions.

n

Contains starter topics and other files designed to produce a user guide
in PDF format.

n

Includes auto-generation of a TOC, glossary, and index.

Product Foldout

User Guide
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TUTORIAL TEMPLATE
Template
San
Diego
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Characteristics
n

Designed to be used alongside self-paced Getting Started tutorial.

n

Tutorial gives you hands-on experience in Flare, guiding you in the basic steps
for creating, developing, and building output.

n

End result is a PDF guide and online HTML5 output with top navigation like a
modern website, instead of the more traditional tripane format.
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DOWNLOADING ADDITIONAL PROJECT TEMPLATES
If you want to use one of the many other templates available from the MadCap Software website
(including older ones that once were available in this wizard), you can click a new link to browse
the templates and download them.

After downloading a project template, you can unzip it and save it to a location on your computer.
Then, next to New from existing, click
and select that project’s main .flprj file.
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Start Page Redesigned
The Start Page in Flare has been redesigned, making it even easier to use. If you do not see it, select
View > Start Page.
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Stylesheet Editor—Ellipsis Button for Editing
Values
In previous versions, the controls for values were displayed next to each property in the Stylesheet
Editor.
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When viewing multiple mediums or media queries at the same time, this could make the interface
quite crowded.

Starting with this version, you will see an ellipsis (…) button in this location next to each property.
This makes the interface much less crowded when multiple mediums or media queries are open.
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When you click this button to edit the values for a property, the appropriate controls and options display, allowing you to choose or enter values.
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You also have the option of clicking in the value field and entering information directly, as long as
you know how to write the valid values.
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CHAPTER 6

Deprecated Features
Following are features that will be removed in the next release of MadCap Flare, alongside features
that we recommend as replacements. For more information on the replacements, see the Flare
online Help.
Deprecated Features

Recommended Replacements

Toolstrip

Ribbons

WebHelp and WebHelp Plus

HTML5 Output

To provide feedback on these deprecated lists, please send an email to:
supportplanrep@madcapsoftware.com
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APPENDIX

PDFs
The following PDFs are available for download from the online Help.
TUTORIALS

Getting Started Tutorial
Product Foldout Tutorial
Side Navigation Tutorial
Top Navigation Tutorial
USER GUIDES

Accessibility Guide

HTML Help Guide

Analysis and Reports Guide

HTML5 Guide

Architecture Guide

Images Guide

Autonumbers Guide

Importing Guide

Condition Tags Guide

Index Guide

Context-sensitive Help Guide

Key Features Guide

Eclipse Help Guide

Language Support Guide

Getting Started Guide

MadCap Central Integration Guide

Global Project Linking Guide

Master Pages Guide
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Micro Content Guide

Source Control Guide: Git

Movies Guide

Source Control Guide: Perforce

Navigation Links Guide

Source Control Guide: Subversion

Plug-In API Guide

Source Control Guide: Team Foundation Server

Print-based Output Guide

Styles Guide

Project Creation Guide

Tables Guide

Pulse Guide

Tables of Contents Guide

QR Codes Guide

Targets Guide

Reports Guide

Templates Guide

Reviews & Contributions Guide

Topics Guide

Search Guide

Touring the Workspace Guide

SharePoint Guide

Transition From FrameMaker Guide

Skins Guide

Variables Guide

Snippets Guide

What's New Guide

CHEAT SHEETS

Folders and Files Cheat Sheet
Print Output Cheat Sheet
Shortcuts Cheat Sheet
Structure Bars Cheat Sheet
Styles Cheat Sheet
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